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The information in this publication is subject to change without notice and does not represent a
commitment on the part of gINT Software. The software described in this document is furnished under
a license agreement or nondisclosure agreement. The software must be used or copied only in
accordance with the terms of the agreement.

Printed November 6, 2008

Disclaimer: Every effort was made to ensure accuracy. However, gINT Software makes no warranty as
to the correctness of this information or the supplied files.

All rights reserved worldwide. No part of this publication may be reproduced in any form or by any
means without the prior written consent of gINT Software. Comments are welcome and become the
property of gINT Software. gINT® is a registered trademark of gINT Software. All other products
mentioned are trademarks or registered trademarks of the respective producers.

© Copyright 1985-2008 by gINT Software, Inc.
Printed in the United States of America

Web Site: www.gintsoftware.com
E-mail: support@gintsoftware.com
Sales: sales@qgintsoftware.com

gINT Software, Inc. —&  www. gintsoftware.com
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Installation and Setup

This reference manual is intended to provide an overview of how to install and use the gINT for ArcGIS
toolbar feature within an ArcGIS application. It does not provide instructions for using ArcGIS
applications. Please refer to your ArcGIS documentation from ESRI for information on using ArcGIS
products. See the For Further Assistance section at the end of this document for additional resources.

gINT for ArcGIS is an add-on toolbar for ArcGIS applications from ESRI. gINT for ArcGIS is compatible
with any of the following applications, Version 8 or later:

e ArcView
e ArcEditor
e Arcinfo

With the gINT Toolbar for ArcGIS, users of ArcGIS applications can:
R Link gINT project data with their ArcGIS projects.
= Open and view gINT projects from within ArcGIS applications.

R’ Preview, print, and export gINT reports from within ArcGIS applications.

Using gINT for ArcGIS, you can add the dimension of subsurface data to your other data layers in
ArcGIS. This document will guide you through the installation and activation processes, and help you
get started using this simple--yet powerful--tool.

Installation Process Overview

There are several installation steps and procedures that are involved before you can use the gINT for
ArcGIS Toolbar within an ArcGIS application. This chapter will cover the required installation tasks in
the following order:

1. Installing the gINT ArcGIS Toolbar program
2. Adding the toolbar to your ArcGIS application

3. Registering your gINT Toolbar for ArcGIS license (for a standalone or network)

R Important: You must have a licensed or trial version of gINT Software and a compatible
ArcGIS application installed to run the gINT Toolbar for ArcGIS. These software
programs should already be installed prior to running the gINT for ArcGIS Toolbar
installation program.

System Requirements
The following software is required to run the gINT Toolbar for ArcGIS:
e An ESRI ArcGIS application, Version 8 or later

e gINT version 5.1.063 or later
e gINT Toolbar for ArcGIS program

Note: If you are using the trial version of gINT, you must use the version dated 16 February
2003 or later. Select Help » About gINT to determine the version of gINT you are running.

1
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If you purchased the program and are running a version prior to version 5, you can either upgrade to
version 5 or download the trial version. If you purchased a build prior to 5.1.063, you can download and
install the latest version from the gINT Software Web site at no charge. If you have an older version of
the trial, you can download the latest trial version from our Web site at no charge, or request a CD.

Installing the gINT for ArcGIS Toolbar

Y we strongly recommend that you make a backup copy of the CD before running the
installation. The easiest method is to copy the entire contents of the CD to your computer or
network. You do not have to run the installation from the CD. Replacement media is $50.00 per
set (plus shipping).

To install the gINT Toolbar for ArcGIS, complete the following steps:

1. Close any open applications. If you are installing from the CD, you can select Start » Run, and
type D:\SETUP.EXE (where “D” is the letter of your CD drive) or navigate to the root of the CD,
using Windows Explorer, and double-click the SETUP.EXE file. If you copied the contents of the
CD to your computer or network, use one of these methods and specify the appropriate folder.

2. When you run the SETUP.EXE file, you see the Welcome dialog box:

42 Welcome

Welcome to the glNT Arc GIS 3 Toolbar Setup
program. This prograrm will install glNT Arc GIS 9
Toolbar on your computer.

[tis strangly recommended that you exit all Windows programs
biefare running this Setup Program.

Click Cancel to quit Setup and close any programs you hawve
running. Click Mext to continue with the Setup prograrm .

WARMING: This program is protected by copyright law and
international treaties.

Unauthorized reproduction or distribution of this program, or any
portion of it may resultin severe civil and criminal penalties. and
will be prosecuted to the maximurm extent possible under law.

2

gINT Software, Inc. —&  www. gintsoftware.com



gINT FOR ARCGIS, VERSION 1

3. Click Next to continue or Cancel to exit the setup program. If you click Next, you see the
Choose Destination Location dialog box:

pose Destination Location

Setup will install giMT Arc GIS 3 Toolbar in the following folder.

Toinstall into a different folder, click Browse, and select another
folder.

“ou can choose notto install gINT Arc GIS 9 Toolbar by clicking
Cancel to exit Setup.

[fyou hawe installed gINT®to & network server and yvou are setting

up aworkstation, use the Browse button to locate the netwark folder
where giMNT has been installed.

Destination Folder

CAProgram FileshgINT8gINTAGISTool Browse...

< Back

Cancel ‘

4. This screen displays a default target folder for the installed files. Accept the default or select a
different folder by clicking the Browse... button.

5. Click Next when you are ready to continue with the installation. You see the Backup Replaced
Files dialog box:

Backup Replaced Files

This installation program can create backup copies of all files
replaced during the installation. These files will be used when the
software is uninstalled and arollback is requested. Ifbackup
copies are not created, you will only be able to uninstall the
software and not roll the system back to & previous state. Do wou
want to create backups of the replaced files?

* Yes

" Mo

Flease selectthe directory where the replaced files will be copied.

Backup File Destination Directony

ChAQINTEgINTArcGISToohBACKLUFP Browse...

<Bock [ Ne> ] cConcal |

6. Click Yes to create backup copies of the installation files or No to install the program without
making backup copies. When you click Next, you see the Start Installation dialog box:

3
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*Z Start Installation

You are now ready to install gINT Arc GIS 8 Toolbar using the
tallowing settings:

Installation Folder:
CAProgram Files\glNT#gINTAGISTool

Backup Folder:
MO BACKUP

Click the [Next button to begin the installation or click the Back button
to change the installation information.

< Back Cancel

7. Click Next to install the program. When the installation is finished, you see the Installation
Complete dialog box:

Installation Complete

gINT Arc GIS 9 Toolbar has been successfully installed.

Press the Finish button to complete the installation.

v Showthe Readme file (gINTACGISToolbarbd)

8. Click Finish to close the dialog box.

4
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Configuring gINTArcGISTool.ini

If you need to be able to reference a geo database in a location other than the folder where the
toolbar is installed, you need to create an INI file that identifies the database’s location. This file must
be called gINTArcGISTool.ini, must be placed in the toolbar’s installation folder, and have the following
contents:

[gINTArcGISTool]
GeoDBFolder = pathname

where pathname is the fully qualified path to the geo database’s folder, and does not include the
filename.

Note that adding a gINTArcGISTool.ini file only works in gINT Toolbar For ArcGIS versions 1.1.021 (Sept.
2007) and later. If you need to obtain an updated version, contact gINT Software.

Adding the Toolbar to ArcGIS

Before you can run gINT from your ArcGIS application, you must add the toolbar file (this is a .DLL file)
to ArcGlIS. To add the toolbar, complete the following steps:

1. Launch the ArcGIS application and select Tools » Customize from the main menu. You see the
Customize dialog box:

Toolbars l Cu:ummand&] Dption&]

Toolbars:

[w] b aitt bl iy A Mew. . |

130 Analyst

[[] Advanced Editing |

[] Annatation |
|

[ ArcPad

] ArcSean

[] Contest Menus

[] Data Frame Tools

[ Dizconnected Editing

Diraw

] Editor

] Effects

[1GPS ¥

Keyboard. .. | Add fromfile...l Close

2. From the Toolbars tab, click Add from file. You see an Open dialog box. Navigate to the
location where the gINT ArcGIS Toolbar program was installed:

Reszet...

5
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Open PR

Laok in: | (9 gINTAreGISToal =] & =5 -

(] gints. d
[ 5] aturarcgisTool.di

File name: || LI Open I
Files of type: IT_I,Ipe Libraries [*.olb, " th,* dil) j Cancel |

3. Select the “gINTArcGisTool.dll” file and click Open. After the toolbar is added, you see the
Added Objects dialog box:

Added Objects...

GintT oolbar

alM TIrpartT ool
glMTFenceT ool
glMTSelectT ool

alM TProjectPropzT ool

6
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Customize

gINT FOR ARCGIS, VERSION 1

Click OK to close the dialog box. The Toolbars tab now displays the gINT toolbar for ArcGIS

Toolbars l Enmmands] Dptiu:uns]

T oolbars:

[] Spatial Analyst
Standard

[1 Streettd ap

] Survey &nalyst
[1 Survey Editar
[1 Survey Explarer

1 Topalogy

[1 Tracking &nalyst

[1 Utiliky Metwark, Analyst
alMT toolbar for ArcGIS 9

Mew...

[

Feset...

(]

A OmIiE | ke |

K.evboard...

Place a check in the checkbox next to the “gINT Toolbar for ArcGIS” item. When checked, the

toolbar is displayed inside your ArcGIS application. Click Close when you finished.

Your ArcGIS application main screen should now look similar to the following:

*_ Untitled - ArcMap - ArcView

File Edit View Insert Selection Tools ‘Window Help
DS » =287 | &S0
B uMm@ed i roms
) : — ; —— =
= gINT toolbar for &... [€]
ol S
Display Selection am| 24| JiE
Drawng K ) @ O~ A~ 72 |[g] Adal >0 ] B 7 u A~ & 4~ o~
' ) 920,66 991,02 Unknown Units

In the screen shot shown above, the gINT ArcGIS Toolbar is floating in the main workspace of the

ArcGIS application. You can also dock the toolbar.

7
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If You Installed the Trial Version

If you are installing the trial version of the toolbar, you cannot modify the location where the files are
installed. The files are always installed to the \<gINT version number>Trial\GIS Tools folder. For
example, if you were installing the toolbar for the trial version of gINT 5, the path would read: C:\gINT
5 Trial\GIS Tools\. With a fully registered version of gINT, you can install the files to the folder of your
choice.

For trial versions, you can bypass the Licensing section that follows. There is no license registration
process with the trial version. The trial version give you access to the program for four hours of use, or
twenty (20) sessions, over any given period of time. The usage time in a session does not start until you
click on one of the toolbar buttons, so if you have an ArcGIS session where the toolbar is not clicked
on, no time is deducted.

The trial version also comes with a sample ArcGIS project and associated gINT project file. Use the File
» Open command in ArcGIS, browse to \<gINT version number>Trial\GIS Tools\Samples, and open the
gINTSoftware.mxd file. You can also open your own ArcGIS models and other gINT projects.

Licensing the gINT Toolbar for ArcGIS

Please complete the following steps to register your gINT for ArcGIS Toolbar:

1. The first time you click one of the buttons on the gINT Toolbar for ArcGIS on a standalone
machine or network workstation, you see the gINT Toolbar for ArcGIS License Not Found dialog
box:

gINT toolbar for ArcGIS 9 License not found
IIhable ta locate a software icense file,
|f wour wigh to activate a software license, click Activate.

If wou wizh to locate a network, folder with an exizting
sofbware licensze, click Browse.

Browse Cancel

2. If you previously registered the software license to your network on another workstation,
select the Browse option and point to the location of the license file. Otherwise, select the
Register option. You see the Please Select a License Type dialog box:

Please select a license type

Depending on the type of zoftware icenze you purchazed,
you can activate a Standalone license on this computer, or a
Metwork license on shared network:, folder.

Standalone Metwork, Cancel

Click

Standalone to install the licensing files to the gINT Toolbar installation folder located
under your gINT installation directory.

8
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Network to launch a browser dialog box that allows you to select the path to a shared
folder on the network server. This folder will contain the license files and must have
read/write privileges for all operators that will be using the gINT Toolbar. You can use an
existing gINT network license folder, or the folder of your choice.

Cancel to close the dialog box and return to the previous screen.

3. If you select Standalone or Network, you seethe Unlock Application dialog box:

m| Unlock Application E|
Code Entry Humber Computer ID Humber
| 296442344 | 3031865

Pleaze phone, fax, or e-mail the following information to glHT
Software:

Your CG number, the "Code Entry Mumber and the "Computer
|0 Mumber" dizplayed above and the type of licenze tranzaction
you request [Activate Standalone License).

'ou will receive an Activation Code to enter below,. Once the
corect Activation Code iz entered, glMT toolbar for ArcGIS 3 will
become unlocked.

Activation Code A: |3gg7‘55‘] 50|

4. Call, fax or e-mail gINT Software with the Code Entry Number and Computer ID Number
displayed on your screen (not the codes shown in this screen shot). You will receive an
Activation Code (in the case of a networked license you will receive two codes).

5. When you enter the Activation Code(s) and click Activate, the gINT Toolbar is activated and
operational.

Licensing Additional Network Workstations

If you selected the Network option in the procedure described above, after installing the license files
to your network from any workstation, you can register additional workstations by pointing each
workstation’s configuration to the location of the network files. When you start the program, you see
the same screen that appears during the initial installation:

gINT toolbar for ArcGIS 9 License not found
Irhable to locate a software licenze file,
IF wou wizh to activate a zoftware icenze, click Adchivate.

|f wour wigh to locate a network: folder with an existing
software license, click Browse.

Browse Cancel

9
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Select Browse and point the program to the network folder containing the licensing files. You can repeat
this process on as many workstations as desired. However, you can only open the gINT Toolbar
simultaneously on the number of workstations for which you are licensed.

10
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Using gINT for ArcGIS

The gINT for ArcGIS toolbar is composed of four buttons. If you “float” the toolbar in your workspace
area, it has the following appearance:

gINT toolbar for A... [X]

o9 B

If you “dock™ it in a fixed position, it looks like this:

CA -

The toolbar can be docked by clicking in the caption (top) line of the floating toolbar and dragging it to
any location in the ArcGIS header area. All gINT/ArcGIS functionality is obtained through the use of
these buttons. Most of the processes implemented by the buttons are performed by gINT.

Clicking on any button for the first time in an ArcGIS session launches gINT, which then resides in your
system tray. Before you can run another session of gINT, you must first close the session that was
launched by clicking on the gINT toolbar for ArcGlIS.

The following sections describe the functionality of each toolbar button:

The gINT Project Import Tool

ok

Clicking the Project Import Tool button launches the Please Select an Import Method dialog box:

Please select an import method

Y'ou can zpecify which glMT projects are to be imported by
gelecting individual project files or by selecting a folder
cohtaining gl T project files.

Select filez Select folder Cancel

Choose from the following options:

e Select Files to select one specific gINT project file (*.GPJ) for import into the ArcGIS model.
e Select Folder to select a folder containing your gINT project files.

e Cancel to return to the ArcGIS application’s main screen.

11
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If you click Select Folder you see the gINT Projects Import dialog box:

. gINT projects import

alMT projects root folder

[ Include subfolders

Automatically import new projects when glMT toolaber iz initialized using the abowve

zettings
Cancel

Use the browse |:|\ button to navigate to the folder location of your gINT project files. Check the
Include Subfolders option to include any subfolders. If you check the Automatically import
new...settings option, the program will automatically open any new projects in the selected folder.

Click OK when you are finished or Cancel to close the dialog box. If you click Select Files you see the
Select gINT Project File(s) dialog box:

Select gINT project file(s) |E|E|

Laok in: | () gINTArEIST ol | £¥ ER-

D

My Recent
Documents

=
[
Deskiop

)

Iy Documents
My Computer
My Network. File name: | j \ﬂl
Flaces
Files of bype: |g|NT Projectz [* gpj) ﬂ m

Navigate to the appropriate folder, select the desired file and click Open.

If you have previously opened a gINT project file in your ArcGIS application, when you click the Data
Import Tool, you see the following dialog box:

12
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Please select an import method

Y'ou can zpecity which glMT projects are bo be imported by
zelecting individual project files, by selecting a folder
containing giNT project files or by zelecting from a list of
projects which have already been impoarted inta the gl T
Toolbar's geodatabaze.

Select files Select folder Geodatabaze Cancel

The Geodatabase option allows you to select from a list of previously imported (or selected) gINT
project files.

gINT projects referenced in GeoDatabase

Froject path

c:hprogram fileshginthprojectzaint zample. apj

c:hprogram fileshginthprojectzagint us lab.gpj

c:hprogram filezginthyprojectzhgint uz.gpj

c:hprogram fileshginthprojects\newproject. apj

g:hgint_Bstemphcustomtpiedmont geo.gpj

q:hraininghcompleted trainings 2005 trainingsh20057 0 meleantgint filez from course schpr...

LCancel

Highlight the desired project and click OK. When you select a project, the tool imports the table with
the coordinate information (see the Selection Tool section of this document) into an ArcGIS
geodatabase file. This file is called gINTGeoDB.mdb and is placed in the same folder as the toolbar

.DLL file.

Each project is displayed as a layer in the ArcGIS model, titled with the full path and file name, a
slash, and the name of the table containing the coordinate information.

Example: g:\gint\projects\my project.gpj/POINT

13
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You can remove projects by right-clicking on a layer name in the layer panel and selecting Remove:

%= gint.mxd - ArcMap - ArcView gﬁ|g|

File Edit Wiew Insert Selection Tools Window Help
ODEH& » 28X | o & |[1:5851 -l an e | | & B a g
CROBHERUE K I

S= Layers

= c:ipragram filesigintpro;
*

= d

ciiprogram Filesigink | fye
- Copy

x

Open Attribute Table

Joins and Relates »
<& Zoom To Layer

‘isible Scale Range »

Usg Symbol Levels

Selection »

+ Label Features

< | Convert Labels bo Annotation. .. jl

Display - Selection ' ” PEetr et | )_]

Drawing v K 2 O Dats 3 0 | B2 U A~ &~ Fr o
Remove laver from data frame Save As Laver File. .. -737.79 325.68 Meters

You could import the same information through standard ArcGIS tools, but if you did, the gINT toolbar
would have no knowledge of the data.

The gINT project files are not opened throughout a session. They are opened only at import time, at
ArcGIS startup to read the coordinate information, and during the refresh operation (see the Properties
Tool section of this document). In addition, the original project files are accessed during operations
invoked by the Selection Tool.

The details of displaying the boreholes from the gINT projects in the ArcGIS model, marker look and
size, labeling, and so on, are defined by the ArcGIS tools. See your ArcGIS documentation for
information on using the ArcGIS tools.

14
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The Selection Tool

The Selection Tool button EF' is the main tool on the gINT for ArcGIS toolbar. The Selection Tool has
the following functionality:

Left-Click Functionality

Left-click on the map, then drag and release the mouse to select/deselect any boreholes within the
selection rectangle.

% gint.mxd - ArcMap - ArcView

File Edit Wiew Insert Selection Tools “Window Help

D=zE& B @ ' =+ |[1:5851 G AHO N EE A
CRORERGE B I ol L

x JCPT- B
EF= Layers
= ciiprogram Fileshgint\pro;
b=
B1 B2 B3

< > .TF'-1 J
Display Selection 20|~ ﬂ ﬂ
Drawing v R O~ A~ [lo] 4ial ~f0 - B ru A~v H~ S~ o
Murnber of Features selectad: 3 -43.42 337.65 Mekers

Right-Click Functionality

Right-click on a borehole to display the following menu options:

gIMT Project Details for 'c\program files\gint\projectsigint us.gpj’
'B-1' Borehole Details

Borehole details, any kable ...

gIMNT Queries

Cukpuk Borehole Logls) r
Specify Mew Baseline
Cwkpuk Fence repork bk

Change gIMT library

e gINT Project Details for ‘name and file path of gINT project associated with the selected
borehole.’: Displays the data from the PROJECT table for the gINT project file associated with
the selected borehole. See the Data Display topic for additional information.

15
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= Project Data

Client | ABC Corporation

Mame | glNT Example

Number | ABC-12345

Location | Somewhere, USA

Elevation Datum | MSL

Depth Log Page [ft)

Llose | FErint

| E xport | Help

gINT FOR ARCGIS, VERSION 1

e ‘<borehole name>’ Borehole Details: Displays the data from the POINT table for the selected

borehole. See the Data Display topic for additional information.

Bl pOINT Data WHERE PointID="B-1"

Borehole |D

B-1

Total Depth [ft]

45

Date Started

1172172002

Date Completed

1172272002

Surface Elevation [ft]

123.4

Hole Size

6" to 25°, NX to BOH

Any File

Contractor

AAAAA Drilling. Inc.

Method

Hollow Stem Auger

Logged By

A Bore

Checked By

Y. Me

Motes

Weather: Warm, sunny,_ slight

Water Depth During [ft]

17.5

‘Water Depth At End [ft]

16

‘Water Depth After [ft]

155

Hoursz After

48

Depth Log Page [it]

Morth [ft)

255

East [ft)

65

Plunae Ideal

LClose Frint

Export Help

16
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e Borehole details, any table...: Displays a list of all the tables in the gINT project file. If you
select a table, the data for the currently selected borehole is displayed. See the Data Display
topic for additional information.

B8 Available Tables %

Hame Caption
CPT
LITHOLDGY
POINT Borehole
PROJECT
REMARKS
SAMPLE
TESTS
WELL

[ >

€]

Ok Qam::el| Help |

e gINT Queries: Displays the gINT Query list dialog box where SQL queries can be created,
modified, and run. See the gINT Queries topic for additional information.

B8 QUERY LIST X

CHISELIMG LENGTH AND TIME EACH POINT
CHISELIMG LENGTH AND TIME TOTAL
|NUM BH & LEN DRILLING
| THICKNESS BELOW FOUNDATION
| THICENESS BELOW FOLUNDATION EACH POINT
| THICKNESS EACH POINT
~ TOTAL LAYER THICKHESS
-

Row 1
(] 9=
Edit ‘ Print ] Export I
Ok J LCancel Help J
17
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Output Borehole Log(s)...: This opens a submenu with options to output the currently selected
borehole or all selected boreholes. If no boreholes are selected, a second choice is not
displayed. See the Report Output topic for additional information.

g Qutput Options

Select a log I j

Preview (+
Printer
Export to File

Output File |

PDF Resolution [dots per inch] |3I]I] I

Image Besolution [dots per inch]

Image Color Depth IMonuchmme _I
Crop image [~

Cancel | Help | Beset |

Specify New Baseline: Displays a dialog box for specifying the East and North coordinates for a
fence baseline. See the Fence Tool topic for additional information.

5 Baseline Coordinates

East Morth |

Ok Cancel Print Export Impaort Help

Output Fence Report: This opens a submenu with options to output selected boreholes or all
boreholes. A best fit baseline through the boreholes is used to generate the fence. See the
Fence Tool topic for additional information.

Bl Fence Output Options
L EE N M ISTRATIGRAPHY & GW - A SIZE 4

Preview (+
Printer
Export to image file

Output File |

PDF Besolution [dots per inch]) |3l]l] l

Image Resolution [dots per inch])

Image Color Depth IMnnochrume _I
Crop image [~

Cancel | Help | Beset |
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Change gINT Library: Displays a dialog box for selecting a different gINT library file.

Right-clicking on a fence baseline displays the following menu options:

gIMT Gueries

Edit: Selected Baseline
Remove Selected Baseline
Specify Mew Baseline
Qukbput Fence report +

Change gIMT libraty
gINT Queries: Displays the gINT Query list dialog box where SQL queries can be created,
modified, and run. See the gINT Queries topic for additional information.

Edit Selected Baseline: Displays a dialog box for editing the East and North coordinates for a
fence baseline. See the Fence Tool topic for additional information.

Remove Selected Baseline: Deletes the currently selected baseline. You can also delete a

baseline using the ArcGIS Select Elements k
and selecting Delete from the menu displayed.

tool by selecting a baseline, right-clicking it,

Specify New Baseline: Displays a dialog box for specifying the East and North coordinates for a
fence baseline. See the Fence Tool topic for additional information.

Output Fence Report: This opens a submenu with options to output selected boreholes or all
boreholes. The currently selected baseline is used to generate the fence. See the Fence Tool
topic for additional information.

Right-clicking on an area that is not a borehole or fence baseline displays the following menu options:

gIMT Queries
Specify Mew Baseline
Output Fence report B

Change gIMT library

gINT Queries: Displays the gINT Query list dialog box where SQL queries can be created,
modified, and run. See the gINT Queries topic for additional information.

Specify New Baseline: Displays a dialog box for specifying the East and North coordinates for a
fence baseline. See the Fence Tool topic for additional information.

Output Fence Report: This opens a submenu with options to output selected boreholes or all
boreholes. A best fit baseline is used to generate the fence. See the Fence Tool topic for
additional information.

The Fence Tool

The Fence Tool button allows you to draw a basel

ine onto your map. Fence diagrams in gINT

generate a report with multiple boreholes that have the specified data posted to each location. The
borehole fence “posts™ are located at the proper horizontal spacing relative to each other along a

baseline. You can draw as many baselines as you wish.
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Select the baseline to use for a particular fence diagram using the Selection Tool EFI button and
right-clicking on the desired baseline. When you are finished selecting, click the Output Fence Report
menu option to print/preview the report.

To draw a baseline, click the Fence Tool Fﬁ button and then click at each vertex location. Double-
click on the last vertex to complete the baseline.

%= Untitled - ArcMap - ArcView

File Edit View Insert Selection Tools MWindow Help

ODFEH& & =8> o~ & 15 Sl a0 B A E
AL O@GED B O M

=l £F Layers oo

=l c:iprogram Filestgintipro
B1 B3

& | > JP- Il
Digplay | Source | Selection 20| ‘J I ’1_
Drawing > R (0 @ O~ A~ 2 |l@) Al =0~ B rulA- &~ 4 o

228,71 449.79 Meters
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To edit a baseline, you can use the Select Elements tool

HE

click the gINT Selection Tool

gINT FOR ARCGIS, VERSION 1

Rk

in ArcGIS. For more control and precision,

button and right-click on the desired baseline. From the context

menu that displays, select Edit Selected Baseline. You see the Baseline Coordinates dialog box:

g Baseline Coordinates

X

North

East
65.7347306017977

253. 91377230213

161.428143653793

271.856287249379

278.054430810913

264_380239354692

233.19820344279

455 767065458684

228 712574705978

449.786227142934

Lancel | FErint | Export | Import I

Help |

You can edit coordinate values, delete vertices, and insert new ones. To delete or insert rows, right-
click in the gray column to the left of the row to highlight it, and then right-click in the selected row.

A context menu displays, from which you can select Delete or Insert. In the Baseline Coordinates

dialog box you can also:

e Print the grid

East,North

Instead of using the Fence Tool to draw a baseline, you
the Baseline Coordinates dialog box.

21
gINT Software, Inc.

Export the data to a CSV (comma separated values) or XLS (Microsoft Excel) file

Import a baseline. When importing, the source file must be in CSV format in the form, such as:

can specify one by typing the coordinates into
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The Properties Tool

B

When you click on the Properties Tool button, you see the gINT Toolbar Properties dialog box:

glHT Toolbar properties
alMT project table containing coordinates of imported gIMT points

[FOINT |
Fields that specify coordinates of imported glMT pointz

# coordinates: [East
' coondinates: [Marth
Z coordinates: [Elevation

Restore from defaults Refrezh gIMT layer data |

alMT library file

||::"\|:ur|:|gram fileshgint8agint us.glb |

Automatic import of gINT projects
Root glNT projects fu:ulu:ler:| |

n r

About giMT Toolbar
Yiew information about giNT Toolbar ...

alMT Toolbar License
Wiew alMT Toalbar licenze infarmation: — ---

ok | LCancel |

The upper portion of the dialog box establishes the table and fields from which the toolbar obtains the
coordinate data. The default values are shown in the screen shot above. The POINT table and the East,

North, and Elevation fields appear in all gINT project databases. You can change these values to the
fields of your choice.

If the fields you enter are in a table other than the POINT table, click the browse g button to the
right of the table field and select a table. Only tables at the POINT (borehole) level are displayed. You
can also use the browse buttons next to the X, Y, and Z Coordinates fields to change their values.

Please be aware that only the X and Y data are used in ArcGIS. The Z data are needed by gINT if you
are outputting a fence diagram whose vertical axis is elevation instead of depth. The Restore from
defaults option refreshes the screen with the default settings (shown above).

You can click the Refresh gINT layer data option to re-import the coordinate data into the
geodatabase. Data is automatically re-imported when an ArcGIS model is opened, so it is only
necessary to use this option if you believe data have changed during a session.
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If you click the launch |:|| button in the About gINT Toolbar section, you see the About gINT Toolbar
dialog box:

About gINT Toolbar [X]

- gIMT Toolbar For ArcEIS by gIMT Software,
\ll‘) Version 1,1.016

Copyright 2002 - 2003 by Salvatore Caronna, All rights Reserved

Please contack gIMNT Software:

7710 Bell Road

Windsaor, California 95492-8518

Yoice: (7071835 1271

Fax: (7070535 1274

Wb Sike: www, ginksoftware, com

E-Mail: support@ginktsoftware, com
sales@ginksoftware, com

Program Path: C:i\Program Files!gIMT\gINT &rcGISToolygIMT ArcGis Toal, dil
Program Size: 593,920 bytes
DatefTime: 107142005 11:03:26 AM

This screen displays information about the toolbar version, along with gINT Software contact
information. Click OK to close the dialog box.
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Clicking the launch |:|| button in the gINT Toolbar License section displays the gINT Software
License Information dialog box:

| gINT Software License Information E|

glMT toolbar for &rclGIS 9 is currently icenzed on thiz
compuker.

Lizenze Optiohz

Licenze transfer

Tranzfer a licenze fram thiz computer to another computer.

Unlicenze glMT

nlicenze gIMNT toolbar for ArciGIS 3 from this cormputer

E xit

This screen displays your gINT license details and provides additional licensing options.

Report Output

The toolbar supports two gINT report styles: logs and fences. However, if you have gINT Logs or
logWRITER+, fences are not available through the toolbar because these versions of gINT do not support
fences. Only gINT Professional and gINT Script Edition support fence reports.
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Both types of reports are output using the Selection Tool

context menu.

= Untitled - ArcMap - ArcView

gINT FOR ARCGIS, VERSION 1

and then right-clicking to display a

File Edit Wew Insert Selection Tools Window Help
DS H&E S B o | & 1565 2 & BON kB & E
QARTO@CD ERO ML
i % .CF'T—'I -~
SF=q'overs|
= ct\program filestgintpro:
®
B .B'z 05—3
®
gINT Queries
Specify Mew Baseline |
Qutput Fence report Y BT H
Change gIMT library %
1 TP-1
< > * =
MJM] Selection @0 | 4 | J Pl_
Drawing > R 0 O A~ o) Al -l Bz g Av S A o
127.04 177.56 Meters

Right-clicking on a borehole gives you the option to output either report type (logs or fences). Right-
clicking on a fence baseline or an area of the model with no borehole or baseline, displays the output

option for fences only.

If boreholes are selected, with logs, you have the option to output selected boreholes or the current
borehole. With fences, you have the option to output the selected boreholes or all boreholes. If no
boreholes are selected, your choices are only the current borehole (for logs) or all boreholes (for

fences).

Whether or not boreholes are selected, if a baseline is used with a fence output, only those boreholes

that project perpendicular to the baseline are used.
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When you select the Output Borehole Log(s) from the context menu, you see the Output Options
dialog box:

vy Output Options

Select a log | ﬂ

Preview i+
Printer
Export to File

The Select a log field is a drop-down list that displays all the log forms in the current gINT library. The
Preview, Printer, and Export to File options allow you to select your method of output.

You can send your report either to the screen (Preview), a printer, or export it to an image file. gINT
supports BMP, JPG, PCX, PPM, and TGA file formats. If the Export option is selected, the last four
fields are enabled.

%~ Note: You can print the report from the preview window.

The Output Options dialog box for fences is the same as for logs except that the first field is labeled
Select a Fence and displays the fence report forms defined in your gINT library.

26

gINT Software, Inc. —&  www. gintsoftware.com



gINT FOR ARCGIS, VERSION 1

gINT Queries

You can view data from your gINT projects using queries (SQL (Structured Query Language)
expressions). Queries can be stored in your gINT library and run through the toolbar. For example, you
might want to run a query for a table containing the borehole name, coordinates, surface elevation,
and depth to bedrock of all boreholes in all projects.

The query function is invoked using the Selection Tool in and right-clicking anywhere in the ArcGIS
model to display the context menu. When you select gINT Queries from the menu options, you see the
Query List dialog box:

B QUERY LIST

Dozerplion [T
CHISELIMG LENGTH AND TIME EACH POINT For eoch bosehale
CHISELING LENGTH AND TIME TOTAL Sum of ol boreholes

|NUM BH & LEN DRILLING Foa pach boiehals

| THICKNESS BELOW FOUNDATION Sum of ol boeholes | 9
| THICKNESS BELOW FOUNDATION EACH POINT  |Fos roch bosehole
| THICENESS EACH POINT Foa each bosehaole

'fim.nj.'l'.n?én THICKMESS Sum of ol beeholes i_aﬁ'im; 315

Edit ‘

Ok ‘ LCancel Help ‘

This is the same functionality that exists in the INPUT application in gINT, but pertains to all the
projects within the ArcGIS model, not just the currently opened project in INPUT. For more information
on Queries, in gINT select Help » Search for Help On... and enter “Queries” in the search text box.
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Data Display

Data can be displayed by invoking the Selection Tool EFI , right-clicking on a borehole, and choosing
either the Borehole Details, any table option, or Borehole details for the currently selected borehole
(such as B-1).

If you select Borehole Details, any table, you can display data for that borehole from any table in the
gINT project database associated with the borehole. Running a query (see the gINT Queries section)
also generates a data display. The following screen shot displays data from the Lithology table
associated with the borehole:

BN | THOLOGY Data WHERE PointID="B-1"

| Borehole | Depth | Bottom | USCS Graphic Description Line Type |~
) _ =

|£

Cloze ‘ Frint ‘ Export ‘ Help I

You cannot edit the data, but you can print or export it to a .CSV or .XLS (requires Microsoft Excel) file
format. You can also left-click on any column heading and sort the rows in ascending order by the data
in the column. If the column is already sorted in ascending order, the rows are resorted in descending
order.

28

gINT Software, Inc. —&  www. gintsoftware.com



gINT FOR ARCGIS, VERSION 1

Unlicensing gINT for ArcGIS

To unlicense the gINT Toolbar for ArcGIS, complete the following steps:

&

1. Click the Properties toolbar button to display the gINT Toolbar Properties dialog box:

X

glNT Toolbar properties
alMT project table containing coordinates of imported gIMT pointz

[FOINT | [z

Fields that specify coordinates of imported glMT pointz
# coordinates: |E ast

Y coordinates:Marth

Z coordinates:|Elewvation

Restore from defaults Refrezh glMT layer data |

alMT librar file
||::"-.|:ur|:|gram fileshaintEhgint us.alb | .

Autormatic import of glNT projects

Root gIMT projects fu:ulu:ler:l |J

r
About gIMT Toolbar

-

Yiew infarmation about glNT Toolbar: ..
alMT Toolbar License
Yiew gIMT Toolbar license infarmation; — ---

ok | Cancel |
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Click the View gINT Toolbar license information browse El button. You see the gINT
Software License Information dialog box:

i, gINT Software License Information E'

alMT toolbar for &rcGIS 9 s currently icenzed on thiz
cornpuber.

Lizenze Optiohz

Licenze transfer

Tranzfer a licenze fram thiz computer to another computer.

Unlicenze glMT

nlicenze gIMNT toolbar for ArciGIS 3 from this cormputer

E xit
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3. To unlicense the product, click Unlicense gINT. You see the Unlicense gINT Toolbar for ArcGIS
dialog box:

il Unlicense gINT toolbar for ArcGIS 9& from ... g|

Code Entry HNumber Computer ID Humber
| 304832008 | 3031865
Unreqgister 1D
/3887691588

Fleaze phone the following infarmation ta gl T Software:

'our CG number, the "Code Entry Humber”', the "Computer D
MHumber”, and the "Unregister D" displayed above and the tupe
of licenze trangaction you request (Unlicenze glMT toolbar for
ArcilS 9).

rou will receive an Activation Code to enter below. Once the
cormect Activation Code iz entered, gINT toolbar for &rciGIS 3 il
become unlicenzed.

Activation Code A: ||

LCancel

6. Call, fax or e-mail gINT Software with the Code Entry Number and Computer ID Number
displayed on your screen (not the codes shown in this screen shot). You will receive an
Activation Code (in the case of a networked license you will receive two codes).

7. Enter the code(s) and click Activate to unlicense your giNT Toolbar for ArcGIS. If you have any
problems unlicensing the product, please contact gINT Software Technical Support.
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For Further Assistance

For further information on using gINT, please refer to the appropriate documentation or applicable
Help topic. The Help system in gINT is extensive, and can be accessed from anywhere in the program
by selecting the Help » Contents menu option.

For assistance on using an ArcGIS application, please refer to the appropriate ESRI documentation or
visit their Web site at www.esri.com/software/arcqgis.
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